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TOPIC -----------------------------------------------------------

This article contains the Readme file for the PCI-based DOS Compatibility Card.

DISCUSSION ------------------------------------------------------

Important Information for users of

• PC Compatibility Card (for use with Macintosh models with a PCI expansion
slot)

• DOS Compatibility Software Update

This document provides late-breaking information that could not be included in
the PC Compatibility Card User's Manual or in the DOS Compatibility Software
Update User's Manual.

Be sure to read the first section, "Before You Install," before you install the
Compatibility Card software. You can read the rest of this document later.
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Before You Install

System Software

If you are using a Power Macintosh or Performa 6100 series DOS Compatible
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System, you can use Operating System 7.1.2 or 7.5.3 with the DOS Compatibility
Software Update.

If you are using a Macintosh Performa 630, Quadra 630, or Performa 640CD DOS
Compatible, you should use System 7.5.3 with the DOS Compatibility Software
Update.

If you are currently using System 7.5, 7.5.1, or 7.5.2, you should install the
System 7.5 Update 2.0 to update to System 7.5.3. You can order System 7.5 Update
2.0 on a CD or a high density floppy disk set for $13 shipping/handling plus tax
from the Apple Order Center by calling 1-800-293-6617, extension 984.

For PC Compatibility Card users, System 7.5 Update 2.0 is on the PC
Compatibility Card Mac OS Software CD. To install the update, follow the
instructions in the PC Compatibility Card User's Manual.

External PC-Formatted SCSI Devices

If you use a dedicated PC-formatted partition or SCSI device instead of a drive
container, you may experience some disk read/write errors. Apple recommends
using drive containers on Macintosh-formatted partitions or SCSI devices as your
primary method of data storage.

Installing Windows 95 Operating System

Follow these guidelines when you install Windows 95 on your system:

• Lock your installation disks.
• Select "Continue" instead of "Retry" at the end of disk 2.
• If you choose to make a startup disk, make sure the disk is already formatted.
An unformatted disk will not be recognized.
• After you are done with the installation, refer to the PC Compatibility Card
User's Manual for information about setting up printing. During installation, do
not print the test page when you are prompted to do so.

Mouse Drivers 9.01

For PC Compatibility Card users, Mouse Drivers 9.01 is available on the PC
Utilities CD. To install the mouse drivers, run SETUP.EXE in the MSMOUSE
directory. If you are using Windows 3.1 or Windows for Workgroups, install both
the DOS and Windows mouse drivers. If you are using Windows 95 or DOS 6.22,
install the DOS mouse driver only.

When you install the DOS mouse driver, the installer may display an error
message indicating that it could not find a mouse attached to the computer. You
can ignore the message if your mouse is properly connected to an ADB port on
your computer or keyboard.

Online Help in the PC Environment

You can install online Help for the PC environment when you install the support
software. If you install Help, it will be available in the PC environment in the
HELP directory in the directory where Apple software is installed.



To start Help in Windows 95:

1. Open "My Computer."
2. Open the C drive.
3. Open the Apple software folder. (The default folder name is "Apple.")
4. Open the Help folder.
5. Double-click the SETUPHLP application.

To start Help in Windows:

1. In the Program Manager, choose Run from the File menu.
2. Type C:\APPLE\HELP\SETUPHLP.EXE and then click OK.

Third-Party Applications

Connectix RAM Doubler

Do not use RAM Doubler and the PC Compatibility Card software together. They are
not compatible.

Symantec AntiVirus for Macintosh

If Symantec AntiVirus for Macintosh (SAM) is installed and you mount a drive
container, your screen may appear to freeze for a few minutes while SAM scans
the container for viruses. The drive container will mount once the scan is
complete.

Microsoft Backup

In Windows 95, you cannot use Microsoft Backup because it needs a PC floppy
drive controller that does not exist in your Macintosh. Instead, use a Macintosh
backup program to back up your PC container file.

However, you can use Microsoft Backup in Windows 3.1 or Windows for Workgroups.
To do so, configure the backup manually by following these steps:

1. Add the following line to the [386enh] section of your SYSTEM.INI file:

device=vfintd.386

Your SYSTEM.INI file is in the WINDOWS directory.

2. Start the Microsoft Backup program.

3. Click "No" in the Auto-configure dialog box.

4. In the Configuration Window, select "1.44 Mb 3.5" in the Drive A: list box.

You may also click "Configure" from the standard toolbar at the top. Do not
click the Compatibility Test. button because it may cause a system "freeze."

5. Click Backup on the standard toolbar.



6. If you are backing up to floppy disks, choose "MS-DOS Path" from the Backup
To: list box. Type "A:\" in the second list box that appears.

You can type a different path to back up to a network device.

7. Continue with your back up.

When you use the Compare or Restore options, you must choose "MS-DOS Path" in
the Compare From and Restore From list boxes, respectively.

Insignia SoftWindows and Soft PC

You can use drive containers created with SoftWindows or Soft PC, but you will
not be able to boot from them. When you select a container created with
SoftWindows or Soft PC, be sure to choose a drive letter other than C.

Windows PaintBrush

Prior to switching to the Macintosh environment, make sure that a menu is not
pulled down in either PaintBrush for Windows 3.1 or PaintBrush for Windows for
Workgroups. When you switch back to the PC environment, the portion of a menu
that overlaps your painting may inadvertently get incorporated into the
painting.

Other Programs

Apple recommends using only the memory management programs that are included
with DOS or Windows. Do not use third-party memory management programs.

A program that attempts to directly control the floppy controller (such as a
backup program) will not work properly.

Any program that sends data to the parallel port during setup or initialization
may cause a blank page to print on your printer.

Some utility programs may incorrectly report the clock speed of the Cyrix 5x86
microprocessor on the 7-inch PC Compatibility Card. This may occur on any PC
that uses this microprocessor.

PC System

Shut Down Properly

IMPORTANT Be sure to quit all open PC applications and exit Windows before
shutting down the PC or the Macintosh. Failing to do so will result in the loss
of any unsaved data and might result in corruption of the drive container or
partition.

When you need to reboot the PC in the PC environment, use the "warm boot"
keyboard shortcut instead of the "cold boot" shortcut whenever possible. You
should only cold boot the PC environment when warm booting doesn't work.
(Cold-booting erases cached data and may corrupt disk data.)



To warm boot the PC, press Control-Alt (Option)-Del.
To cold boot the PC, press Command-Control-Alt-Del.

Symantec Norton AntiVirus for Windows 95

Before you change the number of display colors in the Display Settings control
panel, turn off Norton AntiVirus Auto-Protect by double-clicking its icon in the
Task bar and clicking Disable in the dialog box that appears.

Formatting disks or creating a Rescue disk may not work properly if Norton
AntiVirus is installed. If you encounter a problem, do the following:

1. Double-click the "Norton AntiVirus Auto-Protect" icon in the Task bar.

2. Click Options, and then click Advanced.

3. Change the "Low-level format of hard disk" option to "Allow," and then click
OK.

QuickTime for Windows

When playing QuickTime movies in the PC environment, you may notice
synchronization problems between the audio and video.

International Keyboard Support

If you are using an international keyboard, be sure to install and use the
keyboard files on the PC Utilities  CD. (The supported languages vary from
country to country.) The keyboard files that come with Windows and Windows 95
may not work with your keyboard.

Using a CD-ROM Drive

Currently, the PC Compatibility Card only recognizes the following types of CDs:
PC format (ISO 9660), dual format (disks formatted for both the Macintosh and
PCs), and audio. Some specialized formats are not supported.

Using a Modem

If you are having problems using a modem with Windows 95, you may be able to
correct the problems by disabling the "Use flow control" or "Use error control"
options for the modem. To do so, follow these steps:

1. Click the Start button, choose the Settings menu item, and then choose
Control Panel.
2. Double-click the Modem icon.
3. Click the Properties button.
4. Select the Connection tab in the dialog box that appears.
5. Click the Advanced button
6. Turn off the "Use flow control" or "Use error control" options, and click
OK.



Also, make sure to set the modem speed to 19200 baud or less.

Macintosh System

Starting Up the PC and Macintosh Environments

Allow the Macintosh to completely finish rebuilding the desktop before
attempting to switch to the PC environment. If you switch during the rebuilding
of the desktop, a system "freeze" could occur.

Also, the Energy dialog box may appear each time you start your Macintosh; you
can turn off this message at startup by opening and closing the Energy Saver
control panel.

If you set up your Macintosh to switch to the PC environment on startup, disable
the shut down warning in the General Controls control panel. Otherwise, you may
have to wait for your Macintosh to start up when you switch back to the
Macintosh environment.

To disable the shut down warning:

1. Choose Control Panels from the Apple menu.

2. Double click General Controls to open it.

3. In the Shut Down Warning area, turn off the "Warn me if computer was shut
down improperly" checkbox.

4. Close the General Controls window.

Working with Locked PC Containers

You cannot boot from a locked PC container, a PC container that is open on your
desktop, or a PC container that is on a write-protected file server.

You may not be able to mount a locked PC container if file sharing is turned on.
You can correct the problem by either unlocking the PC container or turning off
file sharing.

Configuring Serial Ports in PC Setup Control Panel

After mapping and remapping a PC COM port to one of the Macintosh serial ports,
you may have to restart the PC and the Macintosh for the remapping to take
effect.

If you are using Apple Remote Access (ARA) 2.0 or 2.0.1, you may not be able to
start your Macintosh properly after mapping a PC COM port to a Macintosh serial
port. To correct the problem, restart while holding down the Shift key to
temporarily turn off all system extensions. Then remove the Serial Port
Arbitrator from the Extensions folder inside your System Folder, and restart
your computer. (Prior to using ARA, unmap the PC COM port and restart your
Macintosh.)



You can also correct this problem by upgrading to ARA 2.1 when it is available.

Memory

Some DIMMs (dual inline memory modules) will not work with the PC Compatibility
Card. When you purchase memory, request Fast Page Mode memory instead of EDO
(extended data output) memory.

Printing

Apple LaserWriter Driver

If you are using a PostScript printer, you should install and use the most
recent version of the Apple LaserWriter printer driver software. The current
version number is 8.3. Older versions may generate inverted images when printing
from the PC environment. Apple LaserWriter 8.3 comes with System 7.5 Update 2.0.
It is also available separately on the Apple World Wide Web site.

Windows 95 Add Printer Wizard

When you use the Add Printer Wizard to set up a printer, do not print a test
sheet until the printer is configured according to the instructions in your
user's manual. Then you can print a test sheet by doing the following:

1. In the Printers window, click the icon of the printer you just added.

2. Choose Properties from the Printer menu.

3. In the dialog box that appears, click Print Test Page.

LaserWriter Select 300 and Personal LaserWriter 300 Printers

The LaserWriter Select 300 and Personal LaserWriter 300 printers are not fully
supported. Files printed in the PC environment may not print properly on these
printer models.

PostScript Printing

When printing to a PostScript printer from the PC environment, be sure to print
one file at a time. Printing multiple files may cause a PostScript error. To
verify that the file has finished printing, check the Windows 95 Printer queue.

Epson Emulation

Some documents may not print properly from the PC environment to a
non-PostScript printer using Epson emulation. Here are some suggestions for
correcting common problems. For additional information, see the section on
setting printer options in the PC Compatibility Card User's Manual.

Problem: Text near the top and bottom of each page doesn't print or is cut off,
or text that should print at the bottom of one page prints on the next page.

Solution: Try choosing "No gaps between pages" in the PC Print Spooler



Preferences dialog box, and try printing again. (When you print after choosing
this option, the PC Print Spooler software will print 66 lines per page instead
of 60 lines per page.)

Problem: You have chosen "No gaps between pages" in the PC Print Spooler
Preferences dialog box, but text near the top and bottom of each page still
doesn't print or is cut off.

Solution: Most laser and ink jet printers cannot print close to the edges of a
page. Find out what the minimum margins are for your printer. (Look for this
information in the specifications section of the manual that came with your
printer.) Then set the top and bottom margins to at least these amounts in the
DOS or Windows application from which you are printing.

Printers that Support the "Printer Specific" Option

If you are using the PowerPrint package from GDT Softworks to print on a
PC-compatible parallel printer, you should choose Printer Specific in the PC
Print Spooler Preferences dialog box. Currently, the PowerPrint package is the
only printer driver that supports the "Printer Specific" option.

Saving a Printer File

To save a printer file such as a PostScript file in the PC environment, use the
option in your Windows printer driver to print to a file. Do not map a PC COM
port to a text file in the PC Setup control panel, and then print to that port
in the PC environment.

Networking

Windows for Workgroups TCP/IP and Windows 95

When upgrading from Windows for Workgroups to Windows 95, make sure to install
the Windows 95 TCP/IP stack. You may have problems using the Windows for
Workgroups TCP/IP stack with Windows 95.

Network Drivers

The MacODI and MacNDIS drivers are in the root directory on the PC Software
floppy disk.

Windows 95 PROTOCOL.INI File

If an error message appears stating that there are illegal decimal characters in
the PROTOCOL.INI file, the Windows 95 Network control panel may have incorrectly
removed some of the double quotes necessary within the file. (The MacNDIS$
section in PROTOCOL.INI has some lines with double quotes, placed there by the
SETNET utility.) If you modify network settings with the Network control panel,
it removes the double quotes from the file. To correct the problem, restore the
double quotes in the file.

Use MacODI with Netware Client 32



In Windows 95, use the MacODI driver to connect a Netware 32-bit client to a
Netware 4.1 server.

Using ODI with Windows 95

You may experience system "freezes" if you are using NetBEUI or TCP/IP with ODI
in Windows 95. To correct this problem, delete the following line from the
STARTNET.BAT file in the NWCLIENT directory:

C:\WINDOWS\ODIHLP.EXE

Also, add the above line to the end of your AUTOEXEC.BAT file.

Shared Folders and Disks

Sharing Floppy Disks and CDs is not Supported

A floppy disk or a CD should not be set up as a shared folder between the
Macintosh and PC environments. This is unsupported and can cause unpredictable
results.

Adding/Removing Shared Folders in Windows 95

When you add or remove a Shared Folder, the View in "My Computer" does not
immediately change. It requires two refreshes to correctly update the Shared
Folder status.

Opening or Saving Shared Folder Files

With some Windows 95 programs, you may not be able to open or save files in a
shared folder. You may have to move a file out of the shared folder before you
can open it, or save a file to a different location and then move it into the
shared folder.

In Windows 3.1 or Windows for Worgroups, you cannot save a file to a shared
folder that is empty. To work around this problem, type a full path and filename
into the Save As dialog box, or keep at least one file in a shared folder.

Naming Shared Folders

When you name a folder in the Macintosh environment that you intend to share
with the PC environment, you may want the name to be within the DOS 8.3
character filename guidelines. Otherwise, the sharing software will truncate and
translate name to fit the guidelines. For more information about naming files,
see your DOS manual.

Network Disks as Shared Folders

If you set up a shared disk on a network as a shared folder and later the
network configuration changes, you may continue to be prompted with a dialog box
at startup to mount a shared disk that no longer exists on the network. To
prevent the dialog box from appearing, reassign the drive letter to a new drive.
If you cannot remember the drive letter, drag the PC Setup Preferences file to



the Trash.

PC Clipboard

Using Compressed Images in the Clipboard

In some cases, you may need to expand a compressed image file in the Macintosh
environment to correctly transfer the image to the PC environment.

Tips

If you are having trouble copying and pasting text or images between the
Macintosh and the PC environments, try the following tips:

• Instead of using the Paste command, use the Paste Special command if it is
available in the application you are pasting into.

• If you cannot paste an image into a word processing program in the PC
environment, try pasting the image into a graphics program, such as PaintBrush.
Then, copy the image to the clipboard from the graphics program and try pasting
into your word processing program.

• Instead of copying and pasting, use a shared folder to transfer an entire file
from one environment to another. Some Macintosh and Windows programs can open
files created on other platforms. For example, ClarisWorks for Windows can open
ClarisWorks files created on a Macintosh, and vice versa. Even if you are using
two different programs, you may be able to save a file in a common file format
that both programs understand, such as RTF for text, and EPS or TIFF for
graphics. (Check the manuals that came with your programs to see if they support
common file formats.)

• If you must use the clipboard to transfer a lot of data or a large graphic,
try transferring the data in smaller pieces or making more memory available to
the application. For more information on increasing a program's memory, see the
"Memory" topic of Macintosh Guide, available in the Guide (?) menu.

• If you are copying and pasting a PhotoCD image, make sure you are copying an
expanded version of the image.

Large Bitmap Transfers

If you are transferring large bitmap images from the PC to the Macintosh
environment, you may have to increase the memory allocated to the PC Clipboard
application. To increase the memory allocation:

1. Open the System Folder, then open the Extensions folder.

2. Select the PC Clipboard icon, open the File menu, and choose Get Info.

3. In the Preferred Size text box, enter a larger memory allocation, such as
1000K.

4. Close the PC Clipboard Info window.



Pasting Graphics Created in Microsoft Word 6.0 for Macintosh

If you have difficulty copying a graphic from a Microsoft Word 6.0 document in
the Macintosh environment and pasting it into the PC environment, try this
method instead:

1. Select the graphic in Word 6.0 and choose Cut from the Edit menu.

2. Place an insertion point in the Word 6.0 document, open the Edit menu, and
choose Paste Special.

3. In the Paste Special dialog box, select Picture format and click OK.

4. Select the graphic you just pasted, and choose either Cut or Copy from the
Edit menu.

5. Switch to the PC environment, and try pasting the graphic.

Video

For best results, use Apple multiple scan monitors with the PC Compatibility
Card.

Video Driver switching in Windows 95

Some 16 color 640x480 modes use the Windows 95 video drivers instead of the ATI
video drivers. The ATI options will not appear in the control panel when the
Windows 95 video drivers are being used. To make the ATI options available,
change the color depth to a higher value, such as 256 colors.

Monitor Adapters

Selecting a "pass-through" mode on a monitor adapter may cause the PC
Compatibility Card to incorrectly sense the monitor. When the PC Compatibility
Card does not sense the monitor because of an incorrect monitor adapter setting,
it will automatically assume that the monitor is a 14" RGB monitor and restrict
the resolution to 640x480. Make sure that the monitor adapter correctly
represents the attached monitor.

AppleVision 1705 Display

The AppleVision 1705 Display will only appear to the PC as a DDC monitor if you
use the optional 1705 VGA adapter cable and a VGA-to-Macintosh video adapter to
connect the display to the PC Compatibility Card. Using the standard
Apple-supplied cable will result in the monitor being identified as a 17"
multiscan monitor. Although the PC Setup control panel lists Multiscan 17" in
the Displays pop-up menu, you should select AppleVision 1705 in the Windows
Display control panel.

AppleVision 1710 and 1710AV Displays

If the PC Setup Control Panel indicates an Apple 14" monitor when an AppleVision



1710AV monitor is connected, do the following:

• Reinstall the AppleVision software that came with the monitor.

• If you are using only this monitor, or you are connecting two monitors with
the AppleVision 1710AV used to view the Macintosh environment, make sure to
connect one ADB cable between your monitor and your computer, and another ADB
cable between the port on the monitor and your keyboard.

Macintosh 21" Color Display

If you are using the Macintosh 21" Color Display with Windows 95, do not select
a 24 bit driver in the Display control panel, even though it is an available
selection. Select an 8 or 16 bit driver instead. Choosing a 24 bit driver may
cause the PC environment to boot improperly.

Screen Display

When used with some monitors, a particular monitor resolution (such as 640x480)
may cause the display to show a smaller viewable area surrounded by a black
border. To correct the problem, try selecting a different monitor resolution.

If your PC Compatibility Card has 1MB of video memory installed, then the only
refresh rates available at 1280x1024 resolution are interlaced display modes.
However, Apple multiple scan monitors and many third-party monitors do not
support interlaced display modes. To display 1280x1024 resolution, you may have
to upgrade the video memory on the 12" card to 2MB, which supports higher
refresh rates.

If you are using a third-party monitor and it does not display properly, try
these suggestions to correct the problem:

• Use the Windows 95 Display control panel to select your monitor name. If your
monitor name is not available, select the SuperVGA monitor option that matches
the maximum resolution supported by your monitor.

• Use the ATI FlexDesk or the Windows 95 control panel to set the refresh rate
to 60Hz.

• If the monitor still does not display properly, reduce the resolution.

Fixed Frequency Monitors

Playing a Video for Windows (.AVI) file in full-screen mode may not work
properly on a fixed frequency monitor. A multisynchronous or multiple scan
monitor will work properly. Refer to the PC Compatibility Card User's Manual for
information about supported monitors and video modes.

Fixed frequency monitors do not support video "Mode X" (320x240 resolution),
which is primarily used by game programs.

Playing Video Files



When playing real-time based video files or games in the PC environment, you may
notice synchronization problems between the audio and video.

Optimizing MPEG playback in Windows 95

You have three ways to optimize MPEG file playback performance in Windows 95;
you can adjust virtual memory, CD-ROM caching, and ATI MPEG Player settings.
There is no single best way to configure the system. The instructions here show
you where to find the configuration files you can use to optimize playback for
your particular circumstances.

To adjust virtual memory settings, follow these steps:

1. Click the Start button, open the Settings menu, and choose Control Panel.

2. Double-click the System icon to open it.

3. Click the Performance tab, and click the Virtual Memory button.

There are a variety of options in the Virtual Memory window. These options allow
you to let Windows automatically manage your virtual memory, or allow you to set
up virtual memory to try and optimize the performance yourself.

4. Click OK when done and close all the open windows.

5. Shut down Windows and restart for your changes to take effect.

To adjust CD-ROM caching settings, follow these steps:

1. Click the Start button, open the Settings menu, and choose Control Panel.

2. Double-click the System icon to open it.

3. Click the Performance tab, and click the File System button.

4. Click the CD-ROM tab.

5. Decrease or increase the size of the Supplemental Cache to optimize
performance. Also, choose the speed of your CD-ROM drive from the "Optimize
access pattern for" pop-up menu.

6. Click OK.

To set ATI MPEG Player properties, follow these steps:

1. Click the Start button, open the Settings menu, and choose Control Panel.

2. Double-click the Multimedia icon to open it.

3. Click the Advanced tab.

4. Click the plus signs to expand the Multimedia Drivers and Media Control
Devices lines.



5. Select ATI MPEG MCI Driver line.

6. Click the Properties button.

7. Click Settings.

8. Change the CPU Utilization, image size, display, and Audio/Video options in
the MCI ATI MPEG Configuration window.

9. Click OK to save the settings.

Technical Support

Apple will provide technical support for Apple-branded software and for DOS 6.22
because it is included with the PC Compatibility Card. If you are having a
problem with Windows, Windows for Workgroups, or Windows 95, contact Microsoft
Product Support. See the support information that came with your Windows package
for more information.

User's Manual Corrections

Please note the following corrections in your PC Compatibility Card User's
Manual:

• Page 70: The table should indicate that the Apple CD-ROM extension is
installed in the Extensions folder.

• Page 77, 79, 174, 175, 176: Each of these pages contains a DOS "CD" command
that will not work properly unless you type the following DOS command first:

E: <return>

• Page 87: In the AUTOEXEC.BAT file, omit the line that loads Macshare into high
memory. Instead, the line should appear in your CONFIG.SYS file as
INSTALLHIGH=c:\apple\macshare.com.

• Page 90: The PowerPrint package is sold by GDT Softworks, Inc. You can phone
GDT at (800) 663-6222 or (604) 473-3600, or visit their worldwide web site at
http://www.gdt.com.

• Page 111: In "Using Floppy Disk Drives and Floppy Disks," add the following
information to the list: "You can only access an unlocked floppy disk in the
environment that was active when you inserted the disk."

• Page 142-43: Step 4 of "Installing NetWare Client Software" should be, "Insert
the disk containing the NetWare client software and select PC Compatibility
Ethernet Adapter."

• Page 147: Step 2 of "Installing NetBEUI in Windows for Workgroups" should be,
"In Windows, open the Network Setup control panel, click Drivers, and click Add
Adapter. Then select NetBEUI."



• Page 161: The title of the section should be "Installing Microsoft TCP/IP-32
Protocol Stack in Windows 95." To install IPX/SPX for use with an NDIS driver in
Windows 95, see page 159.

• Page 164-65: There is an unnecessary line listed in the PROTOCOL.INI file for
using Microsoft TCP/IP with an NDIS driver in Windows for Workgroups. Delete
ProtocolDot2="FF,F0,E0" (the thirteenth line).

• Page 169-71: After step 10 in "Running the Network Protocol Setup (SETNET)
Utility," the "Important" note is incorrect. It should say, "If you are using
ODI with Windows 95, you may need to manually add the following two lines to
your PROTOCOL.INI file before running the SETNET utility."

Also, Using PC Sound with the PC Compatibility Card only describes Sound Blaster
functionality for DOS and Windows. For information on using Sound Blaster with
Windows 95, refer to online help.
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